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1 Introduction

1.1 About Serial Printer Logger

Serial Printer Logger captures data flow from a serial printers and interprets to electronic documents
like Microsoft Word or Adobe PDF. Serial Printer Logger provides real-time data collection from dot-
matrix printers that connected via RS232, RS485 or Ethernet.

Serial Printer Logger captures serial or network data and writes to a binary log file with RAW data or
decode ESC/P control codes and transfers the data to electronic documents.

Key features of Serial Printer Logger are:

· capability to log multiple ports at the same time. Each port may have fully different settings;
· supports most ESC/P and ESC/P 2 control codes, except custom characters;
· captures and decodes bitmap or raster graphics;
· supports different fonts types and sizes;
· supports various paper sizes;
· supports date/time stamping;
· outputs received data without any changes to a log file;
· data export to ready-to-use Microsoft Word (RTF) or Adobe PDF files;
· program messages logging;
· simple, menu-driven step by step set-up - programming is not required to configure the software

to collect data;
· many plug-in modules that extending program features;
· It supports various operating systems. The logger runs on all versions starting from Windows

2000, including 32 and 64-bit systems.

Unlike most other serial logging applications, Serial Printer Logger can run as a service so that it
starts as soon as the operating system starts and doesn't require a user to log in and run it. It will
continue to run even as a user logon and logoff the workstation. 

It is extremely easy to use! The configuration process is fully menu-driven and has complete,
context-sensitive, on-line help. You can easily customize all input to your exact specifications. Once
you see how easy it is to use Serial Printer Logger, you will never again take data readings by hand!

Typical usage

A typical application for Serial Printer Logger is to replace one or more dot-matrix printers with one
computer that will capture and store documents electronically.

Applications examples

· Data logging systems;
· Remote control systems;
· Alarm systems.

Company home page: http://www.aggsoft.com/
Software home page: http://www.aggsoft.com/serial-printer-logger.htm

http://www.aggsoft.com/
http://www.aggsoft.com/serial-printer-logger.htm
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1.2 Glossary

ASCII - An acronym for American Standard Code for Information Interchange. ASCII files are plain,
unformatted text files that are understood by virtually any computer. Windows Notepad and virtually
any word processor can read and create ASCII files. ASCII files usually have the ".TXT" extension
(e.g., README.TXT).

Binary File - A file that contains data or program instructions written in ASCII and extended ASCII
characters. 

Bit - A binary digit in the binary numbering system. Its value can be 0 or 1. In an 8-bit character
scheme, it takes 8 bits to make a byte (character) of data. 

Bytes - A collection of eight bits that represent a character, letter or punctuation mark.

Cable - Transmission medium of copper wire or optical fiber wrapped in a protective cover.

Client/Server - A networking system in which one or more file servers (Server) provide services;
such as network management, application, and centralized data storage for workstations (Clients). 

COM port - Short for a serial communication port. Most serial communication software
communicates with a computer through a communication port, and most IBM and IBM-compatible
computers support up to four serial ports COM1, COM2, COM3, and COM4. Additional ports can be
added by adding additional hardware.

Data bits - A group of bits (1's and 0's) that represents a single character or a byte. Typically, there
are seven or eight data bits. During an asynchronous communication (e.g., BitCom connecting to
CompuServe), each side must agree on the number of data bits. Data bits are preceded by a start bit
and followed by an optional parity bit and one or more stop bits.

DNS (Domain Name System) - A DNS server lets you locate computers on a network or the
Internet (TCP/IP network) by the domain name. The DNS server maintains a database of domain
names (hostnames) and their corresponding IP addresses. The IP address "8.8.8.8", corresponds to
the DNS name www.google.com.

Flow control - A method of controlling the amount of data that two devices exchange. In data
communications, flow control prevents one modem from "flooding" the other with data. If data comes
in faster than it can be processed, the receiving side stores the data in a buffer. When the buffer is
nearly full, the receiving side signals the sending side to stop until the buffer has space again.
Between hardware (such as your modem and your computer), hardware flow control is used;
between modems, software flow control is used.

Handshaking - is how the data flow between computers/hardware is regulated and controlled. Two
distinct kinds of handshaking are described: Software Handshaking and Hardware Handshaking. An
important distinction between the kinds of signals of the interface is between data signals and control
signals. Data signals are simply the pins which actually transmit and receive the characters, while
control signals are everything else.

Internet - A global network of networks used to exchange information using the TCP/IP protocol. It
allows for electronic mail and the accessing ad retrieval of information from remote sources. 

http://www.google.com
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IP, Internet Protocol - The Internet Protocol, usually referred to as the TCP/IP protocol stack,
allows computers residing on different networks to connect across gateways on wide-area networks.
Each node on an IP network is assigned an IP address, typically expressed as 'xx.xx.xx.xx'.

IP address (Internet Protocol address) - The address of a computer attached to a TCP/IP network.
Every client and server station must have a unique IP address. Client workstations have either a
permanent address or one that is dynamically assigned to them each dial-up session. IP addresses
are written as four sets of numbers separated by periods; for example, 198.63.211.24. 

LAN (Local Area Network) - A network, connecting computers in a relatively small area such as a
building. 

NIC, Network Interface Card - A card containing the circuitry necessary to connect a computer to
a particular network media. Typically, the NIC plugs into the computer's accessory bus, (PCI, USB,
etc.) and provides a network connection such as 10baseFL (fiber Ethernet), thin-net, AUI, etc. 

PC - abbreviation for a Personal Computer.

Parity - In data communications, parity is a simple procedure of checking the integrity of transmitted
data. The most common type of parity is Even, in which the number of 1's in a byte of data adds up
to an even number, and None, in which a parity bit is not added.

Ports - is a connection point for a cable.

Protocol - is a formal description of a set of rules and conventions that govern how devices on a
network exchange information. 

RS232, RS423, RS422, AND RS485 - The Electronics Industry Association (EIA) has produced
standards for RS232, RS423, RS422, and RS485 that deal with data communications. EIA
standards where previously marked with the prefix "RS" to indicate the recommended standard.
Presently, the standards are now generally indicated as "EIA" standards to identify the standards
organization.

Electronic data communications will generally fall into two broad categories: single-ended and
differential. RS232 (single-ended) was introduced in 1962. RS232 has remained widely used,
especially with CNC control builders. The specification allows for data transmission from one
transmitter to one receiver at relatively slow data rates (up to 20K bits/second) and short distances
(up to 50' @ the maximum data rate). This 50' limitation can usually be exceeded to distances of
200' or more by using low capacitance cable and keeping the data rates down to 9600 baud and
lower.

RTS/CTS Hardware handshaking - uses additional wires to tell a sending device when to stop or
start sending data. DTR and RTS refer to these Hardware handshaking lines. You can select whether
you need to use DTR or RTS individually or use both lines for hardware handshaking. See also
Xon/Xoff.

TCP/IP, Transport Control Protocol / Internet Protocol - TCP and IP are communications
protocols, that is, structured languages in which data is communicated between one process and
another, and between one network and another. TCP/IP is implemented in a multi-level layered
structure.
TCP/IP is the 'glue' that ties together the many heterogeneous networks that make up the Internet. 
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Stop bits - In data communication, one or two bits used to mark the end of a byte (or character). At
least one stop bit is always sent.

2 License, Registration and technical support

2.1 License

Copyright © 1999-2019 AGG Software.
All Rights Reserved

SOFTWARE LICENSE

Trial Limited Version

The trial limited version of this software may be used for evaluation purposes at the user's own risk
for a trial period. At the end of the trial period, the user must either purchase a license to continue
using the software or remove it from his/her system.

The trial limited version may be freely distributed, provided the distribution package is not modified.
No person or company may charge a fee for the distribution of Serial Printer Logger without written
permission from the copyright holder. 

Licensed Version

  On payment of the appropriate license fee, the user is granted a non-exclusive license to use Serial
Printer Logger on one computer (i.e. a single CPU), for any legal purpose, at a time. The registered
software may not be rented or leased but may be permanently transferred, if the person receiving it
agrees to terms of this license. If the software is an update, the transfer must include the update and
all previous versions. 

  Registered customers are entitled to free updates during one year from the date of purchase. It
means that for one year you can download and install the latest registered versions of Serial Printer
Logger from our site. If you don't want to purchase an update, you can use the program forever; it will
never expire, but you won't be able to use the latest version. If you purchased the software more than
one year ago, you are no longer entitled to free upgrade and technical support; however, you can
purchase an update to the latest version at a special, greatly discounted price, and this update will
allow you to have free updates and technical support for another year. The type of the update license
must match the type of your existing license.

  Whilst every care has been taken in the construction and testing of this software, it is supplied
subject to the condition that the user undertakes to evaluate the suitability of the control for his/her
purposes. AGG Software makes no representation of the software's suitability for any purpose, and
the user agrees that AGG Software has no responsibility for any loss or damage occasioned by the
use of this software.
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  TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, THE SOFTWARE AND
DOCUMENTATION ARE PROVIDED "AS IS" AND AGG SOFTWARE DISCLAIMS ALL OTHER
WARRANTIES AND CONDITIONS, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT
LIMITED TO, IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR
PURPOSE, CONFORMANCE WITH DESCRIPTION, TITLE AND NON-INFRINGEMENT OF THIRD-
PARTY RIGHTS. 

  TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL AGG
SOFTWARE BE LIABLE FOR ANY INDIRECT, INCIDENTAL, CONSEQUENTIAL, SPECIAL OR
EXEMPLARY DAMAGES OR LOST PROFITS WHATSOEVER (INCLUDING, WITHOUT
LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION,
LOSS OF BUSINESS INFORMATION, OR ANY OTHER PECUNIARY LOSS) ARISING OUT OF
THE USE OR INABILITY TO USE THE SOFTWARE PRODUCT, EVEN IF AGG SOFTWARE HAS
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN ANY CASE, AGG SOFTWARE'S
CUMULATIVE AND ENTIRE LIABILITY TO YOU OR ANY OTHER PARTY FOR ANY LOSS OR
DAMAGES RESULTING FROM ANY CLAIMS, DEMANDS OR ACTIONS ARISING OUT OF OR
RELATING TO THIS AGREEMENT SHALL NOT EXCEED THE PURCHASE PRICE PAID FOR
THIS LICENSE.

  Should any term of these terms and conditions be declared void or unenforceable by any court of
competent jurisdiction, such declaration shall have no effect on the remaining terms hereof. 

  If you do not agree to these conditions you should not install this software.

2.2 Limitations

The unlicensed program works in the trial mode. The program allows to test all features, but it limits
the time and/or amount of processed data. The license key removes all limitations from the trial
version. You may purchase a license key here .

The trial version of our software has the following limitations: 

· The trial period is limited to 21 days. After that time, the program stops working.
· The continuous program work time is limited to two hours. After that period the program shows a

message and stops working;

2.3 How to acquire a license

The unlicensed program works in the trial mode. The license key removes all limitations from the trial
version and allows you to use our technical support for one year.

If you want to buy a program through the Internet, visit the order page of our site. On this page, you
can get the newest information about the registration process, and also find an order link. Please,
follow the “Buy now” link, enter your personal information, and choose the most convenient payment
method for you. Further, you will get a notification and follow the notes in it.

You may find more information about our policies, payment terms, payment methods, and frequently
asked questions on our web site.

5

http://www.aggsoft.com/order/
http://www.aggsoft.com/order/
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2.4 Support

Technical questions support@aggsoft.com

Common questions info@aggsoft.com

Sales questions sales@aggsoft.com

3 Installation

3.1 System requirements

Windows 2000 Professional - Windows 10 (2019), including x64 and x86 OS, Workstation, and
Server OS.

It is necessary to have at least one free COM port, not busy by any device (mouse, for example) to
connect an external device.
It is necessary to have at least one working network interface (card) in your PC.

3.2 Installation process

If any beta-version was installed on your computer, remove it.

Quit of the working Serial Printer Logger on installation time.

Run an installation file.

By default, the installation wizard installs Serial Printer Logger to "C:\Programs Files\Serial Printer
Logger" or "C:\Programs Files (x86)\Serial Printer Logger" the directory of your system disk, but you
can change this path.

In the standard distributive of Serial Printer Logger are no additional modules files, which you can
download from our site.

mailto:support@aggsoft.com
mailto:info@aggsoft.com
mailto:sales@aggsoft.com
http://www.aggsoft.com/
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4 Program use

4.1 Getting started

After you have successfully installed Serial Printer Logger, use the following simple steps to
configure and run it.

Open the Serial Printer Logger program from the Start Menu. 

At program run, you get into the main program window (fig. 1.1.1), main elements of which are the
main menu, the data window, the program messages list, and the status bar. 
- The data window shows incoming data before or after processing. You can configure the data view

mode in the settings
- The drop-down box at the bottom shows all logged program info, warning, and error messages. 
- The status bar shows the current state of the selected data source, errors on the data interface,

and how many bytes were sent or received.
- The toolbar above the data window provides fast access to the configuration.
- The main menu above the toolbar allows you to edit the program settings  ("Options -> Program

settings..."), manage configurations, open the current logfile from the "File" menu (fig. 1.1.2).

Fig. 1.1.1 Main program window

8
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Fig. 1.1.2. "File" menu item

By default (after installation), the program has not any data sources configured. If the list of data
sources on the toolbar is empty, then the program will ask you to add a new configuration.
Otherwise, the program will fill in the list of data sources and try to start logging of data sources
configured. Yes, of course, all your settings are being saved while exiting from the program and
loaded during the program start.

Set-Up is as Easy as 1-2-3

Step 1. Configure one or more data sources.

Click the "Add configuration" button on the toolbar with a big green plus and choose communication
parameters  for your device. The "COM Port settings"  tab of the "Configuration options" dialog
lets you configure your settings.

Step 2. Configure log file.

Select the "Log file" header in the configuration dialog window and enable logging for a necessary
data direction.

Step 3. Define how you want the printer data to be filtered and exported .

The "Plug-in" button on the toolbar in the main window or "Modules" tab in the dialog window lets you
specify how to parse, filter and format your data to the fit the exact format required by your
application. It also lets you pre-define automatic output strings to be sent to an external device. 

Now, the program process and exports data from one or multiple data sources.

4.2 Introduction

The program can work with any serial devices. Before configuring our software, the following
conditions should be executed:

· The device should have an RS-232 serial port interface (you need any additional hardware
converter for the RS-485 interface).

· The device is configured to send data to a serial port with or without requests from a computer
side.

· You know all information about serial port parameters of your device (If your device uses
hardware or software flow control (please, read your device's datasheet), then you should know
about flow control type).

· Device's serial port is connected with a computer serial port using a cable (a null-modem or
other special cable).

· Computer's COM port, to which your device is connected is not busy, for example by another
program.

How to configure port parameters, you can read in the next "Serial port settings " chapter.

12

12
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The program can work with any network interface cards (NIC). Before configuring our software, the
following conditions should be executed:

· If your computer has more than one network interface card (NIC) then Serial Printer Logger will
display a list of all the IP addresses for each NIC installed in your system so that you can
select the IP Address that you want to use. In order for Serial Printer Logger to act as a server,
the computer that it is running on must have at least one network interface card with an IP
address assigned to it.

· If Serial Printer Logger will work as a server and your computer receives the IP address
dynamically from a DHCP server, then you should ask your network administrator to assign a
static IP address to your computer.

How to configure port parameters, you can read in the next "IP settings " chapter.

Serial Printer Logger can save data to a log file(s) without any changes (i.e., create raw binary log
files) or write to log files depending on the parser module selected. In the first case, you can view the
log file with any hex editor and use this data for further analysis and remaking. In the second case,
you can view data with any text editor. You can find more information about log files in the "Log
rotation " chapter. 

You can watch the data in the data window (fig. 1.1.1 ). The data view is fully customizable. You
can watch data in decimal, hexadecimal, or your format. How to customize data view you can read in
the "Data view " chapter and how to customize program view you can read in the "Window view
" chapter.

The program and their plug-ins generate many messages and write them to the list in the main
window (fig. 1.1.1 ) and a protocol file that you can use for administration of the software. You can
also configure types of system messages. More information about it you can read in the "Protocol
and errors handling " chapter.

17

30

7

25 42

7

46
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4.3 Data flow diagram

This diagram may help you to understand the flow of data within our software and a place of each
module. The following chapters describe all plugin types.

Fig. 1.2.1 Data flow diagram

History:

        - The flow of binary data (RAW, unformatted data).

        - The parsed data (formatted data). The data flow is separated into data packets and variables.
Each data packet can be interpreted as a row, and each variable can be interpreted as a column.

Wires with other colors mark other relations with the unstructured data flow.
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4.4 Work complete

The program saves all settings to the Windows registry when it stops working. All opened data
sources will be automatically closed (unlocked, unallocated, or fried).

4.5 Useful advices

1. Look through hint helps on all window elements - it may help you to get a picture of this element's
function. 

2. You can change all program settings without restarting the program. To transfer settings to
another computer, you can do the following:

1. Create a configuration backup from the "File" menu and restore it using the same menu.
2. Alternatively, export the registry node with all program settings. Start regedit.exe and export the

following registry node:

on Windows x64 
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\AGG Software\Serial Printer Logger

on Windows x32
HKEY_LOCAL_MACHINE\SOFTWARE\AGG Software\Serial Printer Logger

3. On another computer import settings to the Windows registry.

Many main window elements have "hot" keys for quick access to its functions.
· Ctrl+S - analogs to click on "Start/Pause" button on the toolbar.
· Ctrl+C - analogs to click on "Clear" button on the toolbar.
· Ctrl+P - opens the window with the configuration settings.
· Ctrl+L - opens the window with the log file settings.
· Ctrl+W - allows you to configure the data view mode.
· Ctrl+R - shows the window with the program settings.
· Ctrl+E - shows the Windows 2000+ service settings.
· Ctrl+M - here you can configure data query plugins, data parser, and other plugins.

4. You can look at the summary statistic that contains summary about sent and received data,
created files, etc. (View - Statistics)

5. You can save program settings to an INI file. It may help to install and use several copies of the
program. You can make your choice from the "Options" menu.

6. The program window can display only the last 10 messages. The full program log file (if activated)
you can open using the "File - View program protocol file" menu item.
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4.6 Configuration

4.6.1 Serial port
4.6.1.1 Serial (COM) port

COM port is short for a serial communication port. Most serial communication software
communicates with a computer through a communication port, and most IBM and IBM-compatible
computers support up to four serial ports COM1, COM2, COM3, and COM4. Additional ports can be
added by adding additional hardware.

Serial Printer Logger can manipulate with many serial ports at the same time (up to 255 serial
ports). 

You can open serial ports in Serial Printer Logger software in two modes:

1. Spy mode. In this mode the program monitor data flow on ports selected. In this mode, Serial
Printer Logger intercepts all data exchange between any Windows application and external
device.

2. Standard. In this mode, the program opens a serial port through Windows API functions, and
read/write data from/to a serial port as a regular Windows application. In this mode opens a
serial port with exclusive rights and other application will not have access to a serial port.

If one or more ports are configured already, then Serial Printer Logger is opening these ports and
starting logging. If the port is opened successful, then the status bar in the main window displays a
status of this port (fig. 1.1.1 ). However, before you should configure serial port parameters. The
configuration can include one or more serial ports with identical settings. For example, if you have
many identical devices, that connected to different serial ports, then you can specify port numbers in
one configuration only. However, if you want to use a serial port with different settings, then you
should create more than one configuration.

You can create the new configuration by clicking the "Plus" button in the main window (fig. 1.1.1 )
or through the "Options" menu. After you clicked the "Plus" button, the dialog window will be opened
(fig. 2.1.2). The dialog window contains few sections with parameters. The "COM port" section is
described in this chapter. 

You can manage the configuration created with a drop-down menu near the "Plus" button (fig. 2.1.1).

Fig. 2.1.1 Access to the port configuration

7

7
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The "COM port settings" tab contains indispensable settings of any serial port: baud rate, data bits,
etc. You should configure it with the same values, that your external device uses for data exchange.

Fig. 2.1.2 COM port parameters

If you are logging data over RS-485 with an additional hardware converter and your converter doesn't
support data direction auto-detection, then specify "RS485 interface mode". This option instructs
Serial Printer Logger to set the RTS line at a low level while data receiving and vice versa. The serial
port driver can detect errors while data receiving (for example, bad quality of a connection line). You
can specify with the "At data receive error clean incoming buffer" option to ignore data blocks,
that contain errors and clean an incoming buffer. 

In some cases, the program can't open a serial port while starting (for example, the port is already
used by other application). With the "Try to open after an unsuccessful attempt" option you can
specify to try to open the serial port again after the interval specified. The program will try to open the
serial port until an attempt will succeed.

Check line status mode

The Windows communication API provides two methods to check for received data and line/modem
status changes: API calls (polling) and an event word. The event word is maintained by the Windows
communications driver. As data is received or line/modem status changes occur, the driver sets bits
in the event word. The application can check the bits to determine if any communication events
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occurred. If so, the application can make the appropriate API call to clear the event word and retrieve
the data or the new line/modem status values.

Windows also provides API calls to retrieve the same status information provided by the event word
but the API calls are slower. Serial Printer Logger uses the event word by default for the fastest
possible performance. Unfortunately, there is at least one communication driver (WRPI.DRV,
included with some U.S. Robotics modems) that doesn't appear to support the event word. For this
and similar drivers, select another mode before Serial Printer Logger will receive data.

If you want to rise data transmit adequacy you can use hardware and/or software data flow control
(fig. 2.1.3). When using hardware data flow control are used some lines (wires) of connecting cable.
Depending on used lines, you must configure checks against corresponding fields.

Hardware flow control

When the hardware flow control options are an empty, as they are by default, there is no hardware
flow control. The options can be combined to enable hardware flow control.

"Receive flow control" stops a remote device from transmitting while the local input buffer is too full.
"Transmit flow control" stops the local device from transmitting while the remote input buffer is too
full.

Receive flow control is enabled by including the "Use RTS" and/or "Use DTR" elements in the
options. When enabled, the corresponding modem control signals (RTS and/or DTR) are lowered
when the input buffer reaches the 90% size of the buffer. The remote must recognize these signals
and stop sending data while they are held low. 

As the application processes received characters, buffer usage eventually drops below the 10% size
of the buffer. At that point, the corresponding modem control signals are raised again. The remote
must recognize these signals and start sending data again. 

Transmit flow control is enabled by including the "Require CTS" and/or "Require DSR" elements in
the options. With one or both of these options enabled, the Windows communications driver doesn't
transmit data unless the remote device is providing the corresponding modem status signal (CTS
and/or DSR). The remote must raise and lower these signals when needed to control the flow of
transmitted characters.

Note that flow control using RTS and CTS is much more common than flow control using DTR and
DSR.

Software flow control

This routine turns on one or both aspects of automatic software flow control based on the value
assigned to the property.

"Receive flow control" stops a remote device from transmitting while the local receive buffer is too full.
"Transmit flow control" stops the local device from transmitting while the remote receive buffer is too
full.

Receive flow control is enabled by assigning "On receiving" or "Both" to the "Type" property. When
enabled, a Xoff character is sent when the input buffer reaches the 10% level of of the buffer size. The
remote must recognize this character and stop sending data after it is received.



15Program use

© 1999-2019 AGG Software

As the application processes received characters, buffer usage eventually drops below the 10% level
of the buffer. At that point, a Xon character is sent. The remote must recognize this character and
start sending data again.

Transmit flow control is enabled by assigning "On transmitting" or "Both" to the "Type" property. The
10% and 90% size of the buffer are not used in this case. When transmit flow control is enabled, the
communications driver stops transmitting whenever it receives a Xoff character. The driver does not
start transmitting again until it receives a Xon character, or the user sets software flow control to
"None'.

Software data flow control can be configured on receive, transmit, or both modes, but so as the great
number of a device doesn't need data sending, select the "On receive" control mode. In case of
activation of data transmit control, a remote object (your device) can send special codes, signalizing
about data transmit stop or start. On default, received from device character 0x11 Hex signalizes to
COM port driver to start data receive and character 0x13 Hex - to stop data receiving from a device.

Fig. 2.1.3 Data flow control

Spy mode

In this mode, Serial Printer Logger doesn't send and receive any data, and only spies on data
exchange, made by other programs. You should enable the "Spy mode" checkbox.
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Also, you must start the logger before any other program that can use the selected COM port. 

After this, the logger will capture and show data exchange over the selected COM port in the main
window. 

Note: You must close the program you monitor, before closing Serial Printer Logger.

Serial data transfer errors

Line errors can occur during data exchange and displayed in the main program window in the status
bar.

UART receiver parity error - occurs if you configured an invalid parity type.

UART receiver overrun,
UART receiver framing error - occurs if you configured an invalid number of stop or data bits.

Transmit timeout waiting for CTS,
Transmit timeout waiting for DSR,
Transmit timeout waiting for RLSD - occurs if you configured invalid hardware flow control, or your
serial interface cable isn't wired for hardware flow control.

Transmit queue is full - occurs if Serial Printer Logger can't send data to a remote device.

Break - Break signal is received.

Port restart

You can also set the program to initiate the serial interface at the specified time. On some old
versions of the Windows NT operating system it could help to avoid the loss of data when the
program has been working for a long time without restarting. Please use the "Additional options" tab
(fig. 2.1.4)
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Fig. 2.1.4 Additional options

Here you can also select the terminal emulation mode. In this mode, the program will remove or
interpret some special terminal sequences automatically.

4.6.2 Network connection
4.6.2.1 TCP/IP settings

UDP vs. TCP

The most commonly used network protocols today are TCP (Transport Control Protocol) and UDP
(User Datagram Protocol). TCP is a proven and reliable protocol, and probably the most widely
implemented protocol in use on IP networks today. However, TCP has a lot of overhead and payload
issues, and can sometimes be ‘too-reliable’ or robust for many applications. In fact, when used as
transport, for many serial-based applications TCP can hinder reliable communications. In contrast,
UDP is a much simpler protocol and is being used more frequently today - particularly in areas where
bandwidth or throughput is constrained. An example is the predominant use of UDP for transport of
wireless data applications.

UDP is first a connectionless protocol. Like TCP, UDP runs on top of IP networks. But unlike TCP,
UDP does little to help with transport delivery or error recovery. Instead, it offers a direct way to send
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and receive packets, letting the software application manage things like error recovery and data
retransmission. Once primarily used for broadcasting small messages, UDP is now used for
everything from browsers to Instant Messaging, Video, and Voice over IP applications.

While a powerful tool, the downside to using UDP is that there is not ‘connection’ report to know that
you have end-to-end connectivity. This often makes detecting whether or not a packet is ‘making it’
from one place to another quite a hassle.

Client vs Server

Serial Printer Logger can be configured to log data from as many ports that you like simultaneously
on a single computer. The program allows you to create multiple configurations for this task. Each
configuration may contain different settings for each TCP/IP port. Each configuration has a set of
TCP/IP parameters that are described below. 

Each port configuration (i.e. TCP/IP connection) in Serial Printer Logger can act as:

1. Client. You will need to specify the remote host IP address and the port number for the TCP/IP
server that you want to connect to. The IP address that you specify in Serial Printer Logger
when configuring it as a client may also be either a URL or the name of a computer located on
your network. For example, if you want to connect to a computer named "Plant1", you can
simply enter "Plant1" for the IP address instead of the actual IP address. If you are configuring
Serial Printer Logger as a client and your network is set up to assign IP addresses dynamically
to each workstation, then you may need to use the name of the computer that you want to
connect to instead of an actual IP address to guarantee a connection.

2. Server. In this mode you should specify the IP address of the local computer will be used and
you only need to specify the port number that you would like to use. If your computer has more
than one network interface card (NIC) then Serial Printer Logger will display a list of all the IP
addresses for each NIC installed in your system so that you can select the IP Address that you
want to use. In order for Serial Printer Logger to act as a server, the computer that it is running
on must have at least one network interface card with an IP address assigned to it. In Microsoft
Windows, the TCP/IP protocol can be configured to automatically obtain an IP address from a
host computer. It means that your computer may not have an IP address until it is connected to
a network server or a host computer. You may need to contact your network administrator to
assign an IP address to your computer if you wish to configure a TCP/IP server connection. This
is done in the network settings for the TCP/IP protocol in your control panel.

After you enter the parameters that you would like to use, you must click the "OK" button to
establish a connection between Serial Printer Logger and the TCP/IP port. If the current port
configuration is set up as a client, it will immediately try to establish a connection to the specified
remote server. If the server is not available, Serial Printer Logger will continually try to establish the
connection until it is successful. If the port configuration is set up as a server, it will listen on the
specified port until a client establishes a connection to it.

If one or more ports are configured already, then Serial Printer Logger is opening these ports and
starting logging. If the port is opened successful, then the status bar in the main window displays a
status of this port (fig. 1.1.1 ). However, before you should configure port parameters that are
described below.

You can create the new configuration by clicking the "Plus" button in the main window (fig. 1.1.1 )
or through the "Options" menu. After you clicked the "Plus" button, the dialog window will be opened

7

7



19Program use

© 1999-2019 AGG Software

(fig. 2.2.2). The dialog window contains few sections with parameters. The "IP settings" section is
described in this chapter. 

To log data from more than one TCP/IP connection, you would create and configure multiple port
configurations. You can manage the configuration created with a drop-down menu near the "Plus"
button (fig. 2.2.1).

Fig. 2.2.1 Access to the port configuration

The "IP settings" tab contains indispensable settings of any TCP/IP port: IP address and port.
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Fig. 2.2.2 TCP/IP parameters

Port

In addition to the IP address, you should specify how to connect to a remote machine. Our software
can be thought of as a trunk line with thousands of individual lines (the ports) which are used to
connect machines. Some ports are considered well-known ports. For example, the port typically
used for network mail systems (SMTP) is port 25, the telnet port is port 23, the network news server
port (NNTP) is typically port 119, and so on. To see a list of well-known ports, inspect the
SERVICES file in the Windows directory (for Windows NT it is in the
WINNT\SYSTEM32\DRIVERS\ETC directory). The SERVICES file is a text file used by Serial Printer
Logger to perform port lookups (which return the service name for the specified port) and port name
lookups (which return the port number for the specified service name). You can open this file in any
text editor to see a list of port numbers, and their corresponding service names. While these well-
known ports are not set in stone, they are traditional and their use should be reserved for the service
which they represent. When writing network applications, you should select a port number that is not
likely to be duplicated by other applications on your network. In most cases, you can choose a port
number other than any of the well-known port numbers. 

The IP address and port number are used in combination to create a socket. A socket is first created
and then is used to establish a connection between two computers. How the socket is used
depends on whether the application is a client or a server. If an application is a server, it creates the
socket, opens it, and then listens on that socket for computers trying to establish a connection. At
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this point, the server is in a polling loop listening and waiting for a possible connection. A client
application, on the other hand, creates a socket using the IP address of a particular server and the
port number that the server is known to be listening on. The client then uses the socket to attempt to
connect to the server. When the server hears the connection attempt, it wakes up and decides
whether or not to accept the connection. Usually, this is done by examining the IP address of the
client and comparing it to a list of known IP addresses (some servers don’t discriminate and accept
all connections). If the connection is accepted, the client and server begin communicating, and data
is transmitted. 

Connection options

If the remote server (in the client mode) or local network interface (in the server mode) is not available
and the "Try to connect after unsuccessful attempt" options is True, then Serial Printer Logger will
continually try to establish the connection until it is successful. The program will try to establish the
connection every N seconds that you can specify in the "Next try after XXX seconds" field.

Allowed IP addresses

This option is active in the server mode and allows you to enter one or more IP addresses that have
access to the server. The server refuses connections from any other IP address. This option is very
useful if you transfer your data over an Internet connection or your server computer is connected to a
big corporate network. You can specify multiple addresses - one per row. If you do not specify any
address here, then Serial Printer Logger will accept connections from all IP addresses.

Firewall settings

After you install Microsoft Windows XP Service Pack 2 (SP2), our Serial Printer Logger may not
seem to work. Windows Firewall, enabled by default, blocks unsolicited access to your computer via
the network and may be blocking the normal operation of the program. To provide increased security
to Windows XP users, Windows Firewall blocks unsolicited connections to your computer. When
Windows Firewall detects incoming network traffic that it does not recognize, a Security Alert dialog
box appears. The security alert dialog box looks like this:
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Fig. 2.2.3 Firewall alert

The dialog box includes the following buttons:
· Unblock this program.
· Keep Blocking this program.
· Keep blocking this program, but Ask Me Later.

For our program to function properly, you must unblock the program by clicking the Unblock button.
Unblocking allows Windows XP SP2 to allow the program to continue to work by adding it as an
exception to your Windows Firewall configuration. Exceptions are specific programs and processes
that you allow bypassing the firewall. After you add a program as an exception, you no longer receive
the security alert. If you choose to continue blocking the program, certain functions will be disabled.

Note: If you are using another firewall software, then please, refer to a firewall manual for
corresponding settings.

Limitations

The specific limit of connections is dependent on how much physical memory your server has and
how busy the connections are:

The Memory Factor: According to Microsoft, the WinNT and successor kernels allocate sockets
out of the non-paged memory pool. (That is, the memory that cannot be swapped to the page file by
the virtual memory subsystem.) The size of this pool is necessarily fixed, and is dependent on the
amount of physical memory in the system. On Intel x86 machines, the non-paged memory pool
stops growing at 1/8 the size of physical memory, with a hard maximum of 128 megabytes for
Windows NT 4.0, and 256 megabytes for Windows 2000. Thus, for NT 4, the size of the non-paged
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pool stops increasing once the machine has 1 GB of physical memory. On Win2K, you hit the wall
at 2 GB.

The "Busy-ness" Factor: The amount of data associated with each socket varies depending on how
that socket's used, but the minimum size is around 2 KB. Overlapped I/O buffers also eat into the
non-paged pool, in blocks of 4 KB. (4 KB is the x86's memory management unit's page size.) Thus,
a simplistic application that's regularly sending and receiving on a socket will tie up at least 10 KB of
non-pageable memory.

The Win32 event mechanism (e.g., WaitForMultipleObjects()) can only wait on 64 event objects at a
time. Winsock 2 provides the WSAEventSelect() function which lets you use Win32's event
mechanism to wait for events on sockets. Because it uses Win32's event mechanism, you can only
wait for events on 64 sockets at a time. If you want to wait on more than 64 Winsock event objects
at a time, you need to use multiple threads, each waiting on no more than 64 of the sockets.

If you have more than 64 connection at a time, then we recommend creating multiple configurations
in our software (the "Green Plus" button). Each configuration will use different port number and will
run in a different thread. This change will allow decreasing the influence of Windows limitations.

Additional parameters

The "Additional" tab contains additional settings of a TCP/IP or UDP connection (fig. 2.2.4).

Simple terminal emulation - the program realizes the simple implementation of some terminal
protocols. If this emulation is enabled, then the program will process some special commands and
character sequences.

Following options are effective only in the "TCP/IP server" mode:

Limit of simultaneous connections - you can define the number of clients that can connect to the
server at the same time. It allows optimizing a server load with a large number of TCP clients.
Disconnect inactive clients after (s) - if a client is connected, but didn't send or receive any data
within the specified time, then the connection with this client will be closed. If you will specify "-1,"
then the clients will not be disconnected. 
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Fig. 2.2.4. Additional parameters

Following options are effective only in the TCP/IP server or client modes:

TCP keep-alive mode

A TCP keep-alive packet is a short packet which is sent periodically by the OS to keep the
connection alive. The connection stays alive because those packets and their replies generate small
traffic on the connection when the application is idle.

Keep-alives can be used to verify that the computer at the remote end of a connection is still
available.

It is simply an ACK with the sequence number set to one less than the current sequence number for
the connection. A host receiving one of these ACKs responds with an ACK for the current sequence
number.

TCP keep-alive can be sent once every KeepAliveTime (defaults to 7,200,000 milliseconds or two
hours) if no other data or higher-level keep-alive have been carried over the TCP connection. If there is
no response to a keep-alive, it is repeated once every KeepAliveInterval seconds. KeepAliveInterval
defaults to 1 second. Some (buggy) routers may not handle keep-alive packets properly. 

Our software supports three modes of keep-alive (fig 2.2.4):



25Program use

© 1999-2019 AGG Software

1. Off - the program doesn't use the keep-alive feature at all. You can disable it if your network is
very stable or your routers do not support it.

2. System - the program will use the keep-alive feature, but use system values of KeepAliveTime and
KeepAliveInterval. These values are stored in the following registry branch:

[HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services\Tcpip\Parameters]
KeepAliveTime (32-bit number) = milliseconds
KeepAliveInterval (32-bit number) = milliseconds

3. Custom - the program will use keep-alive, but you can specify your values of KeepAliveTime and
KeepAliveInterval, that are more applicable for your network and system. Note: in our software, you
should define these values in seconds.

Note: Some routers may not allow keep-alive TCP packets. In this case, the "keep-alive" function will
not work.

4.6.3 Additional parameters
4.6.3.1 Data view change

The data in the main window (fig.1.1.1 ) can be displayed in two modes (fig. 3.1.1):

1. The data can be displayed before processing. Before processing the data I fully comply with
that has been read.

2. The data can be displayed after processing.  After processing the data can be modified
depending on the parser.

7
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Fig. 3.1.1. Data view

Data view settings, that can be configured on the "Data view" tab:

1. View characters with code - the program can interpret and decode bytes as characters. You
can select decoding mode for each range of character codes. If the range doesn't have the
corresponding character, that's why these data can be displayed only in hexadecimal and
decimal code.

2. You can set up the user's format to display a data byte. The directive %d shows to display a
decimal code, the directive %x - hex code. You can set any framing characters before/after the
user format.

3. Highlight data sent on screen - a string with sent data will be highlighted by the selected
color.

4. Character set - allows you to define the character set of incoming data. Windows - Windows
ANSI character set, DOS - OEM character set.

5. Data source custom color - if you've created several configurations then you can define a
custom color for each data source that allows you to distinguish data flows on the "All data"
page in the main window.

6. Split strings by data timeout - this option allows visually splitting data packets in the program
window. Data packets that will be received after the specified interval will be shown on a new
line. If this value is set to 0, then data packets will not be split.
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7. Split continuous data blocks large than - this option allows visually splitting continuous data
flow in the program window. The program will show data on a new line if continuous data is
longer than the specified number of bytes.

8. Split by characters - this option allows to visually splitting continuous data flow in the program
window using the specified symbols. For example (fig. 3.1.1), the program will use a character
with the 0Ah hexadecimal code that is equal to the "LF" ASCII code.

4.6.3.2 Date/time configuration

This group of options (fig. 3.2.1) allows you to configure how timestamps appear in the log file and on
the screen. You can configure the stamp format in the program options .

Fig. 3.2.1 Time stamp configuration

Add to display output for data sent - the time stamp will be added for the sent data displayed on
the screen. The stamp will be added according to the timeout (if the data flow is uninterrupted) or
when a data packet is sent.

Add to display output for data received - the same but for the received data.

Add if data direction has been changed - if the program is sending and receiving data, the time
stamp will be also added when the data transfer direction changes (sending/receiving).

45
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Add at begin of file - the stamp will be added at the beginning of every new log file.

Stamp timeout - if the data flow is uninterrupted, the stamp will be added regularly at the interval
specified in milliseconds.

File prefix/postfix character(s) - the program will use these characters instead of those specified
in the program options  while writing data to a file. For example, it allows you to add the new line
character or another sequence of characters before or after the stamp. Example: >#0D#0A

4.6.3.3 Name and security

This group of options (fig. 3.3.1) allows you to configure the following parameters:

Friendly name - this name will be added before the port number or the data source in the drop-down
list in the main window of the program. It allows you to describe the data source.

Start logging automatically - if this option is enabled the program will start receiving and logging
data automatically when it is launched.

The "Security" option group allows you to protect user operations in this particular configuration with
a password. You can specify advanced security options applied to the entire program in the program
options .

Ask password before start and stop - the password will be required when the user clicks the
"Start/Pause" button in the main window of the program.

Ask password before configuration edit - the password will be required when the user tries to
open the Configuration options dialog box.

45

52



29Program use

© 1999-2019 AGG Software

Fig. 3.3.1. Name and security
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4.6.4 Log files
4.6.4.1 Log rotation

The main function of Serial Printer Logger is logging data to a file (so-called, log file). The "Log
rotation" tab has a rich set of options for it. (fig. 4.1.1).

Fig. 4.1.1 Log-file forming modes

First of all, select log file what you can configure:

· Log file for data received - all data received will be saved using these settings.
· Log file for data sent - these settings will be used to save sent data. If you want to save data

to the same file, as data received, then select the "Log file rotation for data sent" option from the
list and enable two options: "Create log files on disk" and "Write to log for data received." Of
course, you should configure a log rotation for data received before.

Set the "Create log file on disk" option to the checked state. Then you can set path to a folder,
where files will be created with the help of a dialog window, which will be showed up after clicking a
button with the "Folder" picture. You should select a necessary folder in the dialog window and click
the "OK" button. 
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Log file path - the full path to a local or network folder, where the program will create new log files.
The network path should be specified as: \\COMPUTER NAME\Folder\

Note: If the program works with network files, it greatly increases data flow through your network and
decreases writing speed. Please, consider creating small log files. If your incoming data flow is fast,
you may create log files locally. Later, you may sync a local folder with a remote folder using any 3rd
party utility.

A log file name can be stamped with date and time. In this case, a new log file is created
periodically. The format of a timestamp depends on the selected period. For instance, if the "File
name prefix" field is set to "sample," the "File extension" field to "log," and the "File name
format" option is "Daily," then each log file created will have the format "sampleYYYYMMDD.log".
On March 21st, 2003, the log file will be "sample20030321.log". Please, note, that the final extension
(after the final period), remains at the end of the file name.

Write to log - the option allows you to select when the program writes data to a log file. This feature
is disabled in some loggers, and if the parser plugin is not available.

· Before parsing - the program saves all incoming data without any modifications. If an external
device sends binary data, the logger will create binary files.

· After parsing - the program saves data after parsing. Generally, it is a parsed data packet.
· After filtering - the program saves data after all filter plugins. The logger saves the content of

the "FULL_DATA_PACKET" variable. A filter plugin may transform or fully change the variable. If
you do not use any filter plugin, then this mode works as the previous.

· Screen content - the program saves data to a log file as you see it in the main window.
Generally, it is text content; therefore, the program creates a text log file.

The log rotation mode is defined by the following key parameters:

· File name prefix - the text string, which will be added at file name beginning. The prefix may
contain special placeholders like {NAME}. If you create log files before parsing the NAME can
be any date formatting values below. For example: "data{YYYY}_{MM}_{DD}" returns a prefix
like "data2019_01_01". If you create log files after parsing or filtering, you may use any parser
variable. Then the file name may depend on some value in your incoming data.

· File name extension - the text string, which will be a file extension (characters after the dot).

Limit size - the "Limit size" field specifies the maximum size in kilobytes of any log file. If you
specify the zero file size, then the file size is not limited.

You may select from the following modes:

1. Clear file - if the log file size will exceed the limit specified, then the log file content will be
deleted, and file filling will start from the beginning.

2. Rename old - if the log file size will exceed the limit specified, then the existing log file will be
renamed.

3. Shift (no threshold) - the older data over the limit specified will be removed from the log file.
4. Shift (with threshold) - in this mode the program will wait when the file size will exceed the limit

specified + the threshold value. After this, the older data over the limit specified will be removed
from the log file.

If the program continuously works for a long time, it is possible that the log file will have a large size
and this file will be inconvenient for looking and analyzing. Therefore, there is the possibility to create
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files in dependence with the time on a computer. You can select one variant predefined or set up a
new one:

· Daily - the file will be created with a name containing a prefix, and date in format DDMMYYYY,
where DD is two-digit day sign, MM is two-digit month sign, and YYYY is four digits of the
current year. The filename extension will be added at the end of the file.

· Monthly - the file will be created with a name containing a prefix, and date in MMYYYY format.
The filename extension will be added at the end of the file.

· Each data packet in different file - in this mode, the program splits data flow to a different file.
In this mode you should configure the parser or the program will split a data by timeout about
300 milliseconds.

· Don't create new file - in this mode, the program will write all data to one file. It is
recommended for a small data flow. Otherwise, your log file will be too big, and a performance of
the program will fall down.

· User's format - a file will be created with a name containing a prefix and date in showed by you
format (for example, DDMMYYYY). The filename extension will be added at the end of the file.
The file may not contain format signs, then file name will be constant. You should not use
characters, that the OS doesn't allow in a file name, such as "/,\.*,?" and some others.

· Weekly - create a new file every week. The file name will contain a week number.
· After data timeout - the program will create a new file if the program didn't receive any data at

the specified interval.
· Hourly - the file will be created with a name containing a prefix, and date in format

YYYYMMDDHH, where HH is two-digit hour sign, DD is two-digit day sign, MM is two-digit
month sign and YYYY is four digits of the current year. The filename extension will be added at
the end of the file.

· Constantly named file - the current log file will have a constant name. When creating a new
file, the existing log file will be saved using the new file name that will contain a date and time
stamp.

Date and time formatting codes:

D - a day number (1-31).
DD - a day number with a leading zero (01-31).
DDD - a day of the week in the text form (Mon-Sat), according to the regional settings on this
computer.
DDDD - a day of the week in the full text form (Monday-Saturday), according to the regional
settings on this computer.
M - a month number (1-12).
MM - a month with a leading zero (01-12).
MMM - a month name in the text form (Jan-Dec), according to the regional settings on this
computer.
MMMM - the full month name (January- December).
YY - last two digits of the year (00-99).
YYYY - the full year number (0000-9999).
H - the hour number (0-23).
HH - the hour number with a leading zero (00-23).
N - minutes (0-59)
NN - minutes with a leading zero (00-59).
S - seconds (0-59).
SS - seconds with a leading zero (00-59).
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Example: You want to create a log file every hour. It is desired that file name starts from
"sample_log" and the file extension "txt".

Answer: set file prefix = sample_log_, file extension= txt (without dot!). In file name format show
HHDDMMYYYY. Now the file will be created every hour. Naturally, you can set any formatting
characters combination, described higher.

If you want to access to a log file while the program work, then you should configure access mode
settings  for the log file in the next chapter. 

Add date/time stamp to file name - this option is available for modes #4 and #7 and allows adding
date and time to the file name.

Add data source ID to file name - if this option is activated, then the program will append the data
source name at the beginning of the file name, for example, COM1-sample20030321.log.

Write data/time stamp to file before writing data - if this option is activated, then the program
will write a date/time stamp to a file before each data portion.

Overwrite existing files - this option is available for modes #4 and #7 and allows you to delete an
existing log file before creating a new log file.

4.6.4.2 Log file access

During work can be such situations, when it is necessary to get access to a file with current data
(current log file) from other applications (for example, for data processing). However, while you are
accessing the current log file Serial Printer Logger can't write data to a log file and all data at this
moment will be lost. We recommend using a temporary file for data storage. It is the safest way. (fig.
4.2.1).

33
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Fig. 4.2.1 File access mode.

You can select one from the following variants:

· Ignore and not write - in this mode, the program stop writing to a log file until it is locked.
Therefore, data will be lost.

· Write to a temporary file, then append - a temporary file will be created, to which writing will be
done. After access to the current file will be got, temporary file content will be added to the end of
the main file. However, mind that if file has a timestamp in the name, there can be a situation when
the program copies the content of a temporary file to a new log file, for the next time.

· Display a message and stop work - data will be lost until the dialog window is closed.

You can define your message text, which will be displayed at writing error to a log file. The sound
signal can be on for an additional indication. You can also enable writing a message to a protocol
file.

4.6.4.3 Log deletion

The deletion of files (fig. 4.3.1) will help you to avoid stuffing your hard disk with needless information.
Log files can be deleted either depending on the time of storing or when the maximal number of files
is exceeded.
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When deleting files by the time of their storage, the files that were modified last time before the
specified period are deleted.

When controlling the number of files, the files with the oldest modification dates are deleted first.

You can select both variants of file deletion. In that case, files will be deleted when either of the
conditions is true.

Fig. 4.3.1 Log deletion

4.6.4.4 PDF/RTF logging

4.6.4.4.1  Introduction

PDF logging or RTF logging plugin modules allow you to capture data flow from a serial printer to a
Adobe PDF or a Microsoft Word RTF document. Modules create ready-to-use files, so you may re-
print these files later, copy to another computer or create a backup copy. 

Most printers are using ESC/P codes in their output. The EPSON created the ESC/P printer control
language, the industry standard for simple, sophisticated, efficient operation of dot-matrix printers
was born. With the scalable fonts, high-resolution color raster graphics, and advanced page handling
available with ESC/P 2, EPSON has narrowed the gap between dot-matrix and page printers.
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Features previously found only on laser printers are now available at affordable dot-matrix printer
prices. 

Our modules support most ESC/P commands and allow to create PDF/RTF documents with different
font types and graphics.

4.6.4.4.2  System requirements

The following requirements must be met for "PDF/RTF logging" to be installed:

Operating system: Windows 2000 SP4 and above, including both x86 and x64 workstations and
servers. A latest service pack for the corresponding OS is required.
Free disk space: Not less than 5 MB of free disk space is recommended.
Special access requirements: You should log on as a user with Administrator rights in order to
install this module.

The main application (core) must be installed, for example, Advanced Serial Data Logger.

Notes for Microsoft Vista and above:

Since our software saves data to the registry and installs to the Program Files folder, the following
requirements must be met:

1. You need Administrator rights to run and install our software
2. The shortcut icon of our software will be located on the desktop;
3. Windows Vista will ask for your confirmation to continue the installation.

NOTE: You can configure the user account only once in order not to see the above dialog box any
more. Search Google for the solution of this problem.

4.6.4.4.3  Installing PDF/RTF logging

1. Close the main application (for example, Advanced Serial Data Logger) if it is running;
2. Copy the program to your hard drive;
3. Run the module installation file with a double click on the file name in Windows Explorer;
4. Follow the instructions of the installation software. Usually, it is enough just to click the "Next"

button several times;
5. Start the main application. The name of the module will appear on the "Modules" tab of the

"Settings" window if it is successfully installed. 

If the module is compatible with the program, its name and version will be displayed in the module
list. You can see examples of installed modules on fig.1-2. Some types of modules require additional
configuration. To do it, just select a module from the list and click the "Setup" button next to the list.
The configuration of the module is described below.

You can see some types of modules on the "Log file" tab. To configure such a module, you should
select it from the "File type" list and click the "Advanced" button.
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Fig.1. Examples of installed modules
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Fig.2. Examples of installed modules
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Fig.3. Examples of installed modules

4.6.4.4.4  Glossary

Main program – the main executable of the application. For example: Advanced Serial Data Logger
and asdlog.exe. It allows creating several configuration. Each configuration may use many plugins.

Plug-in - the additional plugin module for the main program. The plugin module extend the
functionality of the main program.

Parser – the plugin module that processes the data flow, singling out data packets from it, and then
variables from data packets. These variables are used in data export modules after that.

Core - see "Main program".
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4.6.4.4.5  Setup

How to enable

This plugin can work in the following products only:
· Serial Printer Logger
· Data Logger Suite
· Advanced OPC Data Logger

If you want to enable this data logging plugin you should open the "Log rotation" settings and select
the necessary file type (fig. 1). If you will click the "Advanced" button then you may adjust the
document settings below.

Fig.1 Enabling module

Document settings

The module allows you to configure the following settings (fig.2):

· Decode ESC/P control codes - If you'll activate this option, then our module will extract
information about a font type and graphics from a data flow. Therefore some options in the dialog
window will be disabled.
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· LQ mode - some printers support LQ mode. This mode allows you to select print quality (draft or
LQ). In the LQ mode graphics have more density, so if you've found that graphics in a document
isn't decoded properly, then try to enable/disable this options.

· Paper settings - select paper size in your document
· Font type - please, select a font type that you want to use in a document. Some printer fonts

don't exist on a PC, so you should select a font that most compatible with your printer font. In
most cases Courier is a best choice. If you want to use another font, then we recommend to use
fonts with fixed size of characters like Fixedsys, Courier. 

· Font size - of you've selected to decode ESC/P codes, then this option is disabled, because
ESC/P controls font size, otherwise your may define size here.

· Font charset - if you're printing documents with non-latin characters, then please, select your
charset here.

· Bold, Italic - allows you to specify a font type if you've not selected to decode ESC/P codes.
· Wrap words - allows you to split very long strings to two or more rows in a document.
· Tab indent - the module will replace a <TAB> ASCII code with this number of spaces. This option

is available if you've selected to decode ESC/P codes.

Fig.2 Module settings

Timeouts

Timeouts allows you to avoid data loss, damage and garbage.
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· Close file (ms) - allows to close the document after this period. If the module didn't receive any
bytes at this interval, then module  writes data from an internal buffer to a file and closes a
document. Next time the module opens document again and restores a last outputting position.
Therefore this timeout allows you to increase a module performance, because decreases a number
of "Open/Close" operations. If you'll specify zero in this field, then the module will not use this
timeout. 

· Close file button - allows to close file manually.
· Reset state (ms) - the module resets its state after this timeout. It allows you to restore an initial

state of the module if a connection with a printer was broken while print a document. After this
timeout the module restores default values of font style, size, graphics mode etc. If you'll specify
zero in this field, then the module will not use this timeout.

· Reset button - allows to reset module state manually.
· Initialize button - this button resets the module state and additionally resets a last outputting

position.

4.7 Program options

4.7.1 Window view

This tab in program options (fig. 6.1.1) allows you to customize the appearance of the main window
of the program (fig.1.1.1 ). You can access this tab through the "Options -> Program options"
menu item in the main window.

7
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Fig. 6.1.1 Window view setting

You can set the following parameters: 

· Start in minimized state - at start Serial Printer Logger will automatically minimize the
program window to the taskbar or to the Systray (fig. 6.1.2).

· Minimize to Systray - while the main window of Serial Printer Logger minimizes, the program
will automatically put its icon to the system panel near the clock.

· Show data window - if you specify this option, then the program will display all data in the
main window. You may disable this option if you log data from many ports on a slow computer.
It reduces the computer's CPU usage.

· Output data on screen in minimized state - if you'll enable this option, then the program will
display processed data in minimized state. If you are logging many data sources on a slow
computer, then you can decrease computer central processor load rate with disabling of this
option.

· Font type - the data will be displayed with this font type in the main window. We recommend
using mono-spaced fonts in this field, such as Terminal, Courier, or System.

· Screen buffer - when the number of lines in the main window exceeds the specified value, the
program deletes old lines from the screen buffer.

· Window view - this option group lets you configure data window view mode (a font color, a font
type, a background color).
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· Transparency - in Windows 2000 and later lets you set the transparency of the main window.
The most left position is the normal window view, and the most right position is maximum
transparency.

· Wrap words - if you didn't configure a parser module or your data flow doesn't contain a blocks
separator, then your data without this option enabled will be displayed as one long string in the
data window.

Fig. 6.1.2 Systray - panel near clock
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4.7.2 Date/time stamp view

This group of options (fig. 6.2.1) allows configuring the format of date/time stamps that will be used in
the main program window and log files.

Fig. 6.2.1 Configuring data/stamp view

Prefix/Postfix characters for display output - these options allow you to define the beginning and
ending characters of a date/time stamp that will be shown in the program window. When outputting
data to a log file, the program uses individual characters  for each configuration.

View mode - allows you to select the standard or define the custom format of the date/time stamp.

Font - this group allows you to define the color and font of date/time stamp.

Add data direction sign to a stamp - if this option is activated, then the program will append TX or
RX to the end of the stamp.

Add data source ID to a stamp - if this option is activated then the program will data append data
source ID at the beginning of the stamp, for example, COM1.

27
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4.7.3 Protocol and errors handling

While the program is running, it may generate many messages about errors or events. All these
messages are being registered in a protocol file. The protocol file may contain messages from the
main program and all working plugins. On this tab, you can define the kind of messages, which you
want to put a protocol file (fig. 6.3.1). Here you can set the maximum protocol file size and the
formatting mode. 

Usually, the protocol file is in the "AppData" folder and has the name of the program with the 'log'
extension.

On Windows 7 and higher: c:\ProgramData\Serial Printer Logger\
On old OS: c:\Document and Settings\All Users\Serial Printer Logger\

You can also open the protocol file from the “File” menu in the main window.

Fig. 6.3.1 Protocol settings

Serial Printer Logger works with three types of messages:

· Information messages - this type of messages informs you about current operations.
· Warnings - warns you about possible failures or errors. Immediately user reaction is not

required.
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· Errors - the program has detected an error which requires user attention.

There is the possibility to log the following events:

· Program messages - messages about start or stop of the program, etc.
· Data query - messages which are generated in a data query module.
· Data parser - messages from a data parser module.
· Data export - messages issued by a data export module.
· Other - other message types.

You can write each type of messages to a protocol file or/and to the list in the main window. Please,
specify necessary options for each message type at "Window" and "File" fields.

If you don't want to allow growing a protocol file size to an unlimited size, then you can enable the
"Clean protocol at program start" or limit protocol file size in the "Size" field.

Some exceptional (unhandled) messages may occur while the program is running. In most cases,
these messages affect the program, and the safest way is to restart the program. Please, specify
the "Restart program at exception" option and the program will be restarted automatically.

If you want to look all program messages, then you can disable the "Don't display messages at
unhandled exceptions" checkbox, and the program will open the exception message window with
detailed information.

4.7.4 Service mode on Windows 2000+
4.7.4.1 Configuration

Windows 2000+ services let you:

· Control service on local and remote computers, including remote computers with Windows
2000+ system.

· Setup actions on emergency service restore in case of failure, for example, auto service or
computer restart (only on computers with Windows 2000 or later).

· Create for services other names and descriptions, to find them easier (only on computers with
system Windows 2000 or later).

· Run service before user login (password input).
· Service can be configured on automatic start after operation system load.

Note 1: you must be logged in as an administrator to change the configuration or control the service
in any way (start, stop, pause, continue).

Note 2: On Windows Vista and later you should start the program with elevated administrator
privileges.

If you want to use the program as a service application, then, please, go to the "Options -> Program
options -> Windows service" tab (fig. 6.4.1), then enable the "Use program as a service" checkbox.
Later, please, specify the start-up type of the service. There are the following variants:
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Fig. 6.4.1 Service settings

1. Automatic - the service starts automatically with Windows, before user login.
2. Manual - you can start the service application from the "Services" control panel (fig. 6.4.1).
3. Disabled - the service is disabled, and does not start at all.

If you want to change the program settings while the program works in the service mode, you can
start a second instance of the program on your desktop, make the necessary changes, and restart
the service with the new settings.

Old Windows versions (before Windows Vista) allows you to use the service in the interactive mode.
In this case, the program places an icon in the system area (fig. 6.4.2).

Fig. 6.4.2 Service icon in Systray
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If the service should write data a database or use another service on your computer, they should be
started before Serial Printer Logger. You can configure a list of these services on the "Program
depends on services" tab (fig. 6.4.3).

Fig. 6.4.3 Service settings #2

Sometimes, you may need to start Serial Printer Logger before starting other services. In this case,
you should:

· Switch the start mode of a target service to "Manual."
· Start Serial Printer Logger.
· Select the necessary service on the "Depending services" tab.
· Select the mode when the logger will start the selected service.
· Restart Serial Printer Logger.

After you configured Serial Printer Logger to work in the service mode, you need to restart a
computer or start the service manually from the "Services" control panel (fig. 6.4.4).
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Fig. 6.4.4 Manual service run (in Windows 2000)

When the service is running, two processes should appear in the Task Manager: sprnloggersrv.exe
and sprnlogger.exe (fig. 6.4.5). The 'sprnloggersrv.exe' application implements an interface between
the service manager and the Serial Printer Logger software. Unlike srvany.exe utility, our service
stops safely.
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Fig. 6.4.5 Process list

If you want to configure the program as a service, then you must be logged with administrator rights.
The service application can be controlled, stopped, or removed with the help of a command-line. Run
sprnloggersrv.exe with the following parameters:

· /? - a short help.
· /I - install service for starting in then manual mode.
· /A - install service for starting in the automatic mode.
· /D - install service in the disabled state.
· /R - remove service from the computer.

4.7.4.2 Windows Vista+ notes

One of the ways Vista's security was improved was by separating system services and user
applications into separate 'sessions'. Keeping the system services isolated helps to secure them
better, but also makes any interactive interface unavailable to the user. That's where the Interactive
Services Detection service comes in. When a service needs to interact with the user, Interactive
Services Detection presents a dialog that will switch the user to the session where the service is
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running so they can interact with the service. For an excellent, detailed description of this, see next
paragraph.

Many sites recommend disabling this service, but doing so will result in you not being able to
interact with any services that require your attention. This service is run manually by default, so there
is little point to disabling it unless you don't want to be bothered by important information from the
software you may be trying to run.

· Display Name: Interactive Services Detection
· Service Name: UI0Detect
· Process Name: UI0Detect.exe
· Description: Enables user notification of user input for interactive services, which enables access

to dialogs created by interactive services when they appear. If this service is stopped, notifications
of new interactive service dialogs will no longer function, and there may no longer be access to
interactive service dialogs. If this service is disabled, both notifications of and access to new
interactive service dialogs will no longer function.

· Path to Executable: %windir%\system32\UI0Detect.exe
· Default Start-up:
    * Home Basic: Manual
    * Home Premium: Manual
    * Business: Manual
    * Enterprise: Manual
    * Ultimate: Manual

4.7.5 Restart & Security

Sometimes the program should be restarted. For example, if you've changed the program settings
remotely and want to reload program automatically with the new settings. To do that, specify the
time for restarting the program on the "Restart & Security" tab in program options "Options-
>Program options". Just specify the time of day, when the program should be being restarted.
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Fig. 6.5.1 Program restart settings

On this tab, you can also protect some actions with the program by a password. To do that, activate
the "Protect by password" option, define a password and select protectable actions.

6 Having problems?

6.1 Program doesn't run or work

It is necessary to make sure in proper time installation on your computer, so as if you put clock after
program installation, protection from use after trial period works.

Also, the program will not work, if you use a software debugger in your environment like WinDbg. In
any other case, please, contact us on support@aggsoft.com.

mailto:support@aggsoft.com
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6.2 FAQ

Question: Does the program work with virtual COM ports? USB-COM converters?
Answer: Absolutely!

Question: Why COM port doesn't open?
Answer: Probably, another program already uses it (the selected COM port). It can be a service
application, for example.

Question: What to do? 
Answer: Close the application that uses this communicative port (for a DOS application close also a
DOS session window). Alternatively, use another communicative port. Probably, a COM port wasn't
properly closed.

Question: Is it possible to set variable data transmit rate or transmit 9 data bits?
Answer: No, the Windows operating system doesn't have such the feature.

Question: What socket type to use: DB25 or DB9?
Answer: It does not matter. All modern computers have DB9 only. Alternatively, they do not have
DB9 sockets at all.

Question: What cable do I need: straight or crossed (null-modem)?
Answer: It depends on your device. Generally, you should use a null-modem (crossed) cable with
the following layout:

Device   |   Computer
_____________
RXD <--> TXD
TXD <--> RXD
GND <--> GND

If a device uses special signals like DTR or RTS, and you don't want to use hardware data transmit
control, you need to connect pins 7 and 8 of the DB9 socket on the device side.

You can find more hardware related articles on our site https://www.aggsoft.com.

https://www.aggsoft.com/rs232-pinout-cable/
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